Evaluating Software Usability of Geographic Information System

Md. Delwar Hossain and Md. Mehedi Masud
SITE, University of Ottawa, Canada
{dhossain, mmasud}@site.uottawa.ca

Abstract
GIS (Geographic Information System) usability is one of the most significant factors of government sectors like the Ministry of Environment, Planning, Forestry, Fisheries, and so on. In this paper, we present a methodology for evaluating the usability of GIS software. We demonstrate how to find out the severity ratings of problems in GIS software. A sample GIS user Interface prototype is designed to scrutinize usability to discover potential problems. Based on the study, experience, and observation, this paper also provides a number of general usability evaluation guidelines for GIS software.

Keywords: GIS, Software usability, usability evaluation guidelines, GIS User interface.

1. Introduction
GISs are now used in many sectors in an organization such as planning, forestry, fisheries, environment, transport, geography, army, land management, marketing studies, health care, emergency services, political analysis, renewable energy resources, remote sensing, and so on to visualize geographical areas. But without proper use, there may be bad effects on users and decision-makers. Therefore, it is necessary to evaluate GIS software during its design-to-production life cycle.

GIS is based on knowledge from geography, cartography, databases, statistics, algorithms, and data structures. In the 1990s, GIS was based on CLI (Command-line Interface) on Workstations/Unix, but today it is in GUI (Graphical User Interface), Web, handheld, and many more forms [2]. The UN and national experts estimate that around €100/person are spent on explicit Geographical Information yearly (mid 90’s, Europe or USA). That is around €30 million for Europe [9].

The GIS is now used by engineers, planners, architects, health care workers, and by different types of users, but there is no specific tool to evaluate GIS software, even the guidelines in the market are not sufficient. Many companies buy and maintain budgets regarding GIS software to accomplish their purposes.

They are not getting a return on their investment in GIS because of the lack of UI (User Interface) design guidelines. As a result, many governments and private organizations, especially in developing countries are losing significant revenues. New GIS technologies are in development, but there are no defined criteria or principles for the evaluation of GIS usability. A number of GIS usability articles are published that emphasize the user’s requirements and problems rather than usability evaluation guidelines.

In this paper, we present GIS usability evaluating well-known GIS software named “ArcView GIS” to find out the severity ratings of problems. A sample GIS user
interface prototype is designed to scrutinize usability, discover potential problems. We also redesign the interface to overcome those problems. Based on the study, experience, and observation, this paper provides a number of general usability evaluation guidelines for GIS software.

The rest of the paper is organized as follows. Section 2 describes the background work of GIS usability, In Section 3 we propose a number of general guidelines for GIS usability evaluation, followed by Section 4 that discusses sample user interface prototypes for GIS. In Section 5, we show a videotaped evaluation. Finally, a brief discussion of the findings and conclusion is described in Section 6.

2. Background Work

Alexandre and Kurt [13] have provided an in-depth analysis of the importance of the usability of scripting languages in GIS. Most GIS software (e.g. ArcInfo, ArcView, MapInfo, etc) provides scripting languages which are not good enough to effectively integrate with other applications and components, but general-purpose scripting languages (e.g. Perl, Visual Basic, etc) have sophisticated frameworks to integrate with other application domains. The usability investigation of Perl scripting language supports the idea that it overcomes the drawbacks of internal scripting languages in GIS software.

Arunas et al. [15] discuss the usability of GPS (Global Positioning System) in GIS. GPS is used for navigation (map-reading) in GIS. They performed experiments on a specific application that integrates GPS data and map data in real time and send them to the server. Java Applets are used for data visualization and an Internet connection is used for exchanging data between the components of the system. The research has suggested further study on map matching methods that could find GPS positions on exact map locations.

Tina et al. [14] conducted usability evaluation experiments on the CUP (Collaborative Urban Planner) system to investigate GIS’s storage and information processing capacities. For measuring the usability and efficiency of the CUP system, they prepare a proposal to construct a new house and garage in a residential area. The CUP system is good enough to check the correct placement of the proposed house and its privacy, daylight and overshadow, and visibility.

David Koller et al. [16] have tested the usability of 3D GIS for visualizing geographical data. They conduct experiments on virtual GIS in the field exercises of the U.S. army to visualize the topography of the terrain around their operating areas. Soldiers evaluated the complexity of using the six degrees-of-freedom window-based steering interfaces, and requested the addition of more navigation features like a directional compass to assist orientation and the ability to hop to a location specified directly by inputting map grid coordinates. A 3D geological spatial database [17] is developed as distributed GIS for geoscientific research. 3D GIS are not yet completely successful. More research is needed for 3D GIS usability evaluation. Volker [24] have mentioned VIZARD (A virtual reality development interface) prototype that guides users and supports them to visualize 2D GIS spatial data in different levels.

Fatima and Joana [5] point out some major faults of online data formats and existing GI (Geographic Information) applications. They performed usability testing in 1998 and the following findings emerge (a) systems are not user-friendly, (b) raster images are not included and require
more information for non-professional use, and (c) it is not easy to produce thematic maps. Again in 1999 web usability testing by 22 participants (GI specialists and university students) found problems in the language used to recognize the main areas of the site, the navigation bar that is seldom used, the excess of text and lack of icons, the very long path to find some information, the search engine, and the downloading process for existing online information. After getting feedback from usability testing participants they re-designed the system and planned to create new modules in future for different types of GI users. David Firman [8] divides usefulness into utility and usability subcategories. Utility determines how well the system’s functionality works whereas usability manipulates (Nielsen, 1993) how well users accomplish their tasks. He considered a new approach to gather usability data instead of using video cameras. He considered a direct feed off of the monitor to provide clarity of analysis that a video tape could not possibly reproduce.

David Lanter [3] described that appropriate GUI (Graphical User Interface) design for users can help to understand, learn, use and analyze spatial data in GIS easily and efficiently. GIS usability [11] can be studied by giving questionnaires, performing structured interviews and direct observation, and other information from the User. GIS user interfaces should be different for beginner, frequent, and expert users. Task breakdown, Workflow, and User requirements are the three most important components of well-structured GIS user interface design. There is further research to be done in user-centered design for future generations of GIS.

Haklay and Tobon [1] evaluated the usability of different levels of computer literacy people and used these in different perspective. According to them an iterative development process is needed to get better GIS usability. Their notion of usability deals with safely, effectively and enjoyably performing tasks, which is the goal of HCI (Human-Computer Interaction) as well.

The visual representation is one of the major and prime tasks of GIS, and for this Alysson et al. [26] have mentioned visual variables whose classification and properties are defined in order to visualize a map in a ideal way. The visual variables are position on geographical plan, size, color, value, grain, orientation, and form, and its properties are associative, quantitative, selective, and ordered. Based on the aforementioned visual variable and their properties, the usability of GIS representation can be evaluated.

Potential map production is the prime focus of GIS. Maneesh and Chris [4] have emphasized the route map usability. By cognitive psychology research they describe that an effective route map must clearly indicate the exact length, angle, and shape of each road whether it is less significant or not. Length, angle, and shape generalization are the key factor for better route map production. GIS users face difficulty for adding sound. Based on the participation of 23 undergraduate students, Woo-seob [6] has recommended that haptic display is the easiest and auditory display is the most complicated task for adding sound in GIS.

This paper is inspired by GIS usability studies in the articles [1, 2, 7, 8, 11, 22]. Based on their research, we have designed a sample user interface prototype to find out potential problems and redesigned it to overcome these problems. We have evaluated GIS software named ArcView 3.3 by videotaping and find out the severity rating of problems. This paper presents our experiences, observations, and proposes a number of general guidelines for GIS.
usability evaluation.

3. General Guidelines for GIS Usability Evaluation

These guidelines are informed based on the study, experience, and observation of GIS software and tasks. According to Jakob Nielsen [19], usability can be judged by productivity, learnability, user satisfaction, memorability, and error rates. The following guidelines [3, 8, 11, 18, 22, 24, 26] may apply for the GIS usability evaluation:

- There will be no hidden meanings of any term/name that is used for GIS. The meaning should be written as much as clear. Terms are defined. Its all terms are not easy to understand, and that is why help and instructions should be easy and accessible.
- Non-technical terms are included in the button or icons instead of technical.
- Emergency exit wherever possible is provided.
- Error messages are expressed in simple plain text rather than code or technical meaning.
- The system should be logical and follow real-world conventions.
- GIS is mainly for map presentation, so to view data from a map, a right mouse click function should be provided.
- Sometimes big map (a vast amount of data) takes time to retrieve. In that case visual hints should be provided.
- It should provide GIS standard conventions that are easy to understand.
- GIS database contains huge amount of data. Unnecessary data need not be included in storage (hard drive) for executing the software fast.
- It should follow standard colors for default map presentation.
- The front end design of GIS software might be like use patterns so that user can understand where they have to start, and it should also tell users about what is going on (appropriate message in status bar).

4. Sample GIS User Interface Prototype

GIS User Interface is designed to get feedback in the context of a usability study. In this paper the UI is designed under ArcView, and Arc Avenue is used for source code. First version of the UI prototype is designed, and then based on aspects of heuristics evaluation [8, 18, 21, 25], we got some findings from our UI. In light of those findings, the previous design was changed and redesigned. John and Clayton [27] recommend three design principles for system development so that user can use the system easily, efficiency, and effectively. The principles are an early focus on users and tasks, empirical measurement of usage, and iterative design. Iterative design requires a repeating cycle of modification and testing.

Based on the heuristics evaluation, the following problems were found in the initial GIS user interface prototype:

- The upper buttons of selection boxes are confusing for users, they might jumble the screen clicking these buttons. These two buttons should be removed.
- Delete all themes icon is not easy to recognize and not in its proper place. The icon symbol may change and put that icon in near to map display area.
- There is no proper direction from which users have to start first. There should be hints about getting started.
- There is no emergency ‘Exit’ button. It might be good to include such an ‘Exit’ button for emergency case.
- ‘Spatial Link’ and ‘Spatial Link criteria’ boxes are confusing. These should not both display all time or there might be proper direction to handle of it.
- Display map icons and for
both cases (with or without spatial link) are not clear. The icons should change.
- The error messages are not easy to understand. It is necessary to change the error messages for getting proper guidelines.
- The selection box and the display area box (Fish Info. Query view) are not fixed, and that allows the user to jumble the screen. It should be fixed.
- Display data from map is not easy. There should be a clear indication of how to retrieve data.
- The Add Theme button in the menu and toolbar is always active. It should not be active, need to disable it all time.
- User may click on button in the selection box and view area, and the whole interface will vanish. It should not be in selection tool and display view area as well.

In this prototype, the user interface basically has one main screen. The initial version and recommended final/changed version is included in Appendix A and Appendix B. From Figure 9 to Figure 12 is the initial UI prototype. Figure 13 and Figure 14 is the recommended UI prototype. Figure 9 is the initial selection box and map or data display area without spatial link whereas Figure 10 is with spatial link. Figure 11 is shown to demonstrate the problem with not fixing the selection boxes and view area. Figure 12 is an initial message box that appears when requirements are unsatisfied. Figure 13 is the changed/recommended user interface prototype. Finally, Figure 14 is the proper error message dialog box.

5. Videotaped Evaluation

This section describes the details of the videotaped evaluation. The purpose of this evaluation is to find out the interesting problems that a given task poses to the participants, to recommend implemented solutions, and to find out the severity ratings of problems. The solution to these problems should be in such a way that occasional and non-expert users can perform tasks easily and effectively. We evaluated “ArcView” GIS software with four participants during 2 hours. We found a total of 27 problems. The remainder of this section will illustrate the software, the procedure, malfunctions recognized, malfunction classification, discussion and analysis of the malfunctions, and the severity of malfunctions.

A. About the Software

Here, we describe ArcView GIS software, which was evaluated by 4 users:

ArcView GIS is mainly map representation software. It provides data visualization, query, analysis, and integration capabilities along with the ability to create and edit geographic data. It is the world's most popular desktop GIS and mapping software, with more than 500,000 copies in use worldwide. ArcView makes it easy to create maps and to add your own data to them. It links traditional data analysis tools, such as spreadsheets, databases, and business graphics with maps for a completely integrated analysis system. ESRI (Environmental Systems Research Institute) is the developer of GIS software like ArcView, ArcInfo, ArcGIS, ArcIMS. [Source: ArcView GIS documentation online]

The application’s main window is one kind and after selecting project/document menu, the window is in another kind. The following is a description of the window.

- A top menu (like any other Windows application)
- A side Document menu on left
- Two sets of tools: One is under the top menu, and another one come by selecting project/side document menu
The windows are shown in Figure 1 and Figure 2. Figure 1 is the initial or opening window, and Figure 2 is after selecting project/document menu.

B. Summary of the Procedures

The purpose of Videotaped evaluation is to evaluate the software, not the users. That is why we first decided to invite four users, some from Computer science/engineering and some from other departments. Before welcoming the subject (user), the application had been tested and installed in the lab in order to minimize the time required. The taping session was conducted for four users, and duration was almost two hours. The procedures were explained to users at the beginning of the session:

- Nature and goals of project
- What will happen to the data
- Why user's views are important
- Expected user contributions
- Attention is on evaluating software/user interface, not evaluating individuals
- All notes, logs, etc., are confidential
- Usage of devices
- User can withdraw at any time for any reason

![Figure 1: ArcView GIS application Main window](image1)

![Figure 2: ArcView GIS other window (After selecting project/Document menu)](image2)
Each individual user was given a list of instructions. The instruction includes some task ranging from creating a blank/new view to using charts on data and legends on maps. The following series of questions [28] were asked to individual user in this videotaping session.

- What do you want to do?
- What do you think the system has done?
- What do you think the system is telling you?
- Why did the system do that?
- What were you expecting would happen?

At the end of videotaping session, the recording was reviewed, malfunctions were categorized and analyzed, and finally some recommendations for changes were prepared.

C. List of malfunction recognized

Users were asked to complete the assigned tasks and encountered 27 malfunctions as recognized by the evaluator after reviewing the videotape/recording. The users may have faced more than 27 but the evaluator identified 27 malfunctions. It should be understood that the number and types of malfunction might vary from usability specialist to usability specialist. Let’s look the list of malfunctions below:

i. Complicated for the user to create a new project
ii. Creation of Views and Layouts and adding maps to views are not clear to users
iii. Creation of View frame of Layouts is not easy and clear
iv. Unfamiliar terminology for the users “Add Theme”
v. Misleading label for View->New Theme menu item.
vi. No instructions in New Theme menu item.

vii. Misleading label for View->Add Theme …menu item.
viii. Some error messages like File->Extensions … are so technical that only Expert users can understand them. After clicking some “Available extensions”, there is no way to get back the previous window again.
ix. Help menu is not sufficiently rich for beginner, how to start work on this software is not clearly stated.
x. Side Document menu makes users anxious if they close the document by clicking on x button.
xi. After clicking on any document menu (Views, Table, etc.) the window appears in different places. In some cases in the middle of document menu, and in other cases in the corner. There is no fixed place, this is not user-friendly or aesthetically pleasing.
xii. There is no “Print” option for Tables of Side Document menu.
xiii. Under side Document menu, creation of new Table is difficult.
xiv. Some features of some side document menus are in the top menu, which is really difficult for users to discover.
xv. If the user just double clicks or clicks on New button on any side Document menu (Views, tables, Charts, etc) then a corresponding new document is opened, but after closing the window that document still remains whether users want to keep it or not. There is no message asking whether users want to save it or not.
xvi. The document menu data has no security. There is no lock or password system for specific document like Tables, Charts, etc. Anybody can see all data.
xvii. Vertex Edit and Measure tools of...
Views are not sufficiently clear and easy to use

xviii. **Select feature** tool of Views has a bug. The user can select any portion of a map, but after selecting “Select feature” if the user clicks on the outside of the map then the selection disappears.

xix. In some cases the users cannot find right selection tool.

xx. It is hard to find the Color selection menu/tool.

xxi. **Chart Element Properties** tool of Charts is not understandable during use.

xxii. **Select All Themes** function was not provided by system.

xxiii. **Copy-Paste** function is in some cases ambiguous and did not work as the user expected.

xxiv. After opening “Legend editor” and working on **Color Palette, Font Palette**, etc, when the user clicks on the “Apply” button, the “Legend Editor” window remains. After closing “Legend editor”, the Color Palette/Font Palette window is still there. This creates needless complexity and is confusing for users.

xxv. **Zoom In and Zoom Out** selection is confusing. There is no specific tool to deactivate Zoom In/Zoom Out again.

xxvi. Both tools **Text** and **Draw Point** are considered to be graphical. As a result, users face needless complexity in selecting text or drawing.

xxvii. Activation problem for the theme in the TOC (Table of Content) area by clicking in right place of the theme name.

**D. Malfunctions Classification**

In order to make a list of malfunctions to review and analyze, each of the 27 malfunctions was placed into one of four mutually exclusive categories based on their common characteristics. It should be mentioned that the category placement was based on the evaluator’s judgment. The four categories are listed below:

(i to iv) : Creating projects and adding themes

(v to viii) : Graphics and some other top menu items

(x to xvi) : Side Document enu properties

(xvii to xxvii) : Selection tools complexity

**E. Discussion and Analysis of the Malfunctions**

**E.1 Creating Projects and adding Themes**

**E.1.1 Extract from the Process**

The opening screen shows the side document menu, the top menu, and only two tools. Users were first trying to look at the Project menu to create a new project but the project menu (top menu) does not contain information about creating a new project. Then users looked around in the side document menu, and finally they got “New project” under File menu. While users were clicking on “New Project”, nothing happened and there was no message. Actually, the beginning open window is the new project window for the side Document menu, which is the default. This confused users.

User looked around for a while.

**User:** I am confused as to what to do

**Evaluator:** What do you want to do?

**User:** Could you please explain to me how to create a new project?

**Evaluator:** You should look at “New project” under File menu instead of Project menu.
Evaluating Software Usability of Geographic Information System

It was easy to get to the New Project menu but difficult to understand what to do

After creating a new view, users were trying to add a theme on that view. For this they were looking under Theme menu but “Add Theme” was not there, then they continued to look around, and finally after a while, they found it under View menu.

User: I thought that this should be under Theme menu.

E.1.2 Results of malfunction study

○ How is the malfunction evident?
  Creating a new project and adding a theme on the view was difficult for users because they were not finding it easily, and not understanding what to do.

○ At what stage in the user interaction is it happening?
  The user knew what he wanted to do but was unable to perform the task. This malfunction happened during the action execution stage and task level.

○ Why is it happening?
  In the side Document menu there was no indication that this is a new project window, and that is why users were trying to create new project by clicking “New project” item under File menu. For adding a theme, users thought that this should be under Theme menu but not. There was also a tool for adding a theme but the symbol of that tool was not understandable.

E.1.3 Recommendations for modification

○ As the opening side document window is the new project by default, so we suggest there should clearly be an indication that this is a new project, or when the user clicks on “New project” item under File menu, there should appear a clear message that a new project window is already open.

○ For adding theme on the view, the “Add Theme” tool symbol should change and also “Add theme” item should be placed under Theme menu instead of View menu.

E.2 Graphics and some other top menu items

E.2.1 Extract from the process

When the user was trying to see the extensions under File menu, he clicked on File->Extension. Then from Available Extensions he selects Database Themes and clicks on Ok and sees a window, then he cancelled but the following window (Figure 3) appeared on the screen.

Evaluator: What do you think the application is telling you?
User: I don’t know.
Evaluator: What did you expect to occur?
User: I thought this would give an idea about the theme.

Figure 3: After selecting ‘Database Theme’ extensions, the above window appears
After cancellation, the user tried to get back to the previous window, but the following error message appeared:

![Error Message Image](image)

**Figure 4: Error Message**

**User:** I’m really frustrated now
User was trying to write on top of the map using the Text tool, after that, he was trying to draw some points. Then he thought that he would delete the draw points, so he selected them by choosing “Select All graphics” from the **Edit** menu, and he finally selected **Delete Graphics**.

**Evaluator:** What do you think the application is telling you?
**User:** I don’t know.

**Evaluator:** What did you expect to occur?
**User:** I’m assuming that this is a point that has been added to the drawing.

**E.2.2 Results of malfunction study**

- **How is the malfunction evident?**
  The user was attempting to play with Extensions but eventually could not get back to the previous window normally. After drawing some points the user was playing with Attach Graphics, and Detach Graphics, but there was no response.
- **At what stage in the user interaction is it happening?**
  Actually the user was playing with this item and thought that this would give information about themes but it didn’t. This malfunction happened during the task level, and the wrong interpretation of results happened as well.
- **Why is it happening?**
  After choosing Database Theme from the available extensions, the user was not able to work normally in the previous menu, and the error message was too technical to understand.

Also by writing text and drawing some points on the view menu, user was trying to delete only the drawing point by selecting all graphics, but before the user understood what it meant, it deleted all text and drawing points. There was no message or indication about this.

**E.2.3 Recommendations for modification**

- After choosing available extensions from File-> Extensions… menu, there should be an understandable error message, or the program should be written in such a way that the user can get back his previous window and work smoothly.
- Graphics->Attach Graphics and Graphics-> Detach Graphics menu items are not working properly and easily. We suggest making it easy so that the user can handle it easily or remove it from menu.
- In Help-> About ArcView menu, users are not getting proper information. This is not providing the information on what the software is about. It should be written in such a way that the user can get an idea about the purpose of the software.
E.3 Side Document Menu Properties

E.3.1 Extract from the process

User can create a new view by just double clicking on Views in the side Document menu or clicking on Views and then clicking on “New” button of the side Document menu. After creating a new view, the side document menu is hidden by this, which is shown in figure 5 below.

Figure 5. View window hiding side Document menu

The user accidentally closed the side document window, making the application window look like in the figure 6, which was really unexpected by the user. The first time this happened, the user was too worried about what he did.

Figure 6. By mistake closing side Document menu

After creating a view and adding a theme on it, the user was trying to see tabular data and made a chart using some/all data, but every time windows were mixed up. Windows were not coming in a specific place. The mixed up window is shown in figure 7 of the following.

The user said that it is really not a good way to visualize the data and the map. There is no specific icon/button to clear all views or to get back to the previous window. The user's comment was that managing this series of windows was confusing.

Figure 7: After opening different (Table, Charts, Views) documents
E.3.2 Results of Malfunction Study

- **How is the malfunction evident?**
  Users faced problems in creating a new project for the first time because when they clicked on *New project* under File menu, nothing happened.

- **At what stage in the user interaction is it happening?**
  This is a problem for the stages at the task level.

- **Why is it happening?**
  The side Document menu contains a new project window *initially* but there was no indication about that even after clicking on *New Project* under File menu; there was also no prompting message. After opening more documents like views, tables, charts, etc the windows become mixed up that is why the user sometimes closes the document window.

E.3.3 Recommendations for Modification

- Side Document menu should be fixed so that user cannot move it easily. Better to remove the x button in the document menu so that the user cannot close it.

- We suggest putting a blank space in between the right side of document menu and under the top menu. Whenever the user selects different documents like view, table, chart, layout, or script, the window will appear in that empty space.

- The Print option should be included in the Tables document menu.

E.4 Selection Tools Complexity

E.4.1 Extract from the Process

When adding/changing the color on a map, the user was trying to find the color palette tool or menu, but that was not directly found in any menu. Actually, the color palette was under the Legend Editor, which is shown in Figure 8.

![Figure 8: After closing the Legend Editor](image)

Evaluator: What do you want to do?  
**User:** I'm trying to find the color palette  
When the user opens the Legend Editor, there was a small Symbol box and after double clicking on it, the desired Fill Palette window appeared.  
Evaluator: What do you think this small Symbol box is for?  
**User:** I don't know! May be it is a different symbol list. The user then proceeded to find the color palette window. After searching for a while, he found it.  
Evaluator: Are you satisfied with getting the color palette?  
**User:** Well, not really. I wanted to get it more easily. The user was trying to select all the themes at the same time and looking for a tool to do that. There was no Select All Theme tool or menu. Similarly, the user was trying to measure the distance from one point to another, but after selecting and measuring the distance using the Measure tool, they were not be able to release it.
E.4.2 Results of Malfunction Study

- **How is the malfunction evident?**
  It was hard to find the color palette, and it took long time because this was hidden deeply under Legend Editor or Theme->Edit Legend'
- **At what stage in the user interaction is it happening?**
  This malfunction occurred during the action decision and interpretation of results stages, all at the task level.
- **Why is it happening?**
  Firstly some users don't have full knowledge about the legend and the labeling was also confusing. They were looking for the Color palette but that was under the Legend editor. Malfunction: The system does not have the tool that the user wants.

E.4.3 Recommendations for Modification

- Color selection/change tool should be included in the tool area as well as in the top menu. Right now, it is difficult for the user to find the color palette.
- We suggest comprising Select All Themes tool and menu as well.
- Activating a theme on the view is not very easy. It should be made simple and easy.
- Text and drawing are both considered as graphics. We suggest making them separate and using different buttons for selection and deletion'
- The software is provided a Color palette, Font palette, etc in the Legend Editor. But there is a problem after closing the Legend Editor; the color palette or Font palette window remains on the screen, which is difficult for the user to understand. We suggest closing all relevant windows as soon as the legend editor is closed.

F. Malfunction Severity

Severity rating is important in order to determine the quality and efficiency of software. The developer can fix bugs or remove difficulties to determine the malfunction severity. The severity of a particular malfunction is as significant as the frequency with which it occurs. Each malfunction recognized was given a severity rating based on the effect that the malfunction had on the four subjects who encountered it. In this evaluation, the severity ratings were meant to be analytical. Here are the severity ratings based on the recognized malfunctions from the following table:

<table>
<thead>
<tr>
<th>Severity Rating</th>
<th>Severity Description</th>
<th>Number of Malfunctions</th>
<th>Percentage (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Severe</td>
<td>A ruin usability Problem that might Cause loss of data.</td>
<td>1</td>
<td>4%</td>
</tr>
<tr>
<td>2-High</td>
<td>A recurrent usability problem, which may cause corruption of data</td>
<td>4</td>
<td>14%</td>
</tr>
<tr>
<td>3-Medium</td>
<td>A partial problem that may cause reasonable confusion and frustration. (No data lost or system failure)</td>
<td>6</td>
<td>22%</td>
</tr>
<tr>
<td>4-Low</td>
<td>Non-critical or. general questions about the application, which might cause inappropriate maps presentation and labeling</td>
<td>16</td>
<td>60%</td>
</tr>
</tbody>
</table>

Table 1: Four types (severe, high, medium, and low) of percentage severity rating
6. Conclusion

The initial GIS user interface prototype has been designed and tested. It works fine, but the heuristic evaluation detects some problems. Based on these findings, it is recommended that the UI should be changed. We performed a videotaped evaluation with four participants with the duration of 2 hours. After analyzing the videotape, we noticed 27 malfunctions. This may vary from evaluator to evaluator. Similarly, the severity ratings in this evaluation may be different for different usability specialists. Most of the participants recommended to add more hints and functions of right button click of mouse. GIS usability evaluation tools available in the market are not sufficient. If instructional design ideology as well as good usability and accessibility ideology are properly followed during the design of GIS software, then the users' experience will be enjoyable and successful, and the working environment will not become a barrier to GIS entry and non-expert level users. Developers of ArcView GIS are continually refining their applications to provide improved accessibility for the users. They need to gain a better understanding of how users are using and attempting to use their products. Usability tests like videotaped evaluation are some of the essential steps in the process of making products more usable to all kinds of users. The paper proposed eleven GIS usability guidelines.

The GIS and software expert should establish guidelines for GIS usability evaluation. There are insufficient GIS usability tools around; even the guidelines are not rich and detailed. Automated GIS usability tools need to be developed. GIS is used in most important sectors, and decision-makers rely on it, but due to the lack of guidelines, there is a great deal of wasted revenue all over the world.

Reference


[28] Timothy C. lethbridge, Course Notes: CSI 5122, Available at: http://www.site.uottawa.ca/ftp/pub/courses/Winter/csi5122/coursenotes/
Appendix A

Initial version of User Interface Prototype

Figure 9: Fish Info. Query Menu, selection box, and its display area.

Figure 10: Fish Info. Query menu, selection box, and display area with more attributes

Figure 11: The same Fish Info. Menu but selection box, and display area are matched up.

Figure 12: Error message dialog box. [The message is “Spatial Analyst is not installed. To view Pond Inventory, Spatial analyst is needed.”]
Appendix B

Redesign the initial version of User Interface prototype

**Figure 13:** New Fish Info. Query Menu, selection box, and its display area screen. [The arrow marked icons/buttons, selection box, and places need to change.]

**Figure 14:** New error message dialog box. [The new message is “Spatial Analyst key is not installed. To view Pond Inventory, Spatial analyst key is needed. Spatial analyst key is a hardware component.”]